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General Requirements on Wakefield Solver ¥

Solver Capabilites

» Fully Time Domain
» 3D Structures
» Ultra-short bunches

ﬂ Numerical Method

» 3D Numerical Scheme
» Dispersion Free in longitudinal direction

{l

» Moving Window
» Parallel computing
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General Requirements on Wakefield Solver

Solver Capabilites

; gg“%’tl:gjrgsomam ::: > Resistive Walls with Freq. Dep. Conductivity
» Surface Roughness & Metal Oxidation Effects
» Ultra-short bunches

ﬂ Numerical Method ﬂ

> 3D Numerical Scheme <:| > Time_ Domain SIBC Model and
> Dispersion Free in longitudinal direction Special Implementation to Preserve
ﬂ Dispersion Properties of 3D Method

» No Time & Mesh refinement

» Moving Window
» Parallel computing
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Dispersion-Free Numerical Method U S
Staggered Finite Volume Time Domain Method
Volume Integral Form of
Maxwell’s Equations
Time Continuous MGE
No Splitting

§Edi:_dijﬂHdv -
v ty Space —h=-M .C-e Time nel n
} Discretization dt g M Lej = G(At)(ﬁj

I ~d =
= — )

indA J[udth dv %e=|v|glc-h—lvlgl-j h

§8E-dA=IpdV l

ov \Y
§[u|:| .dA=0 Dis_perjsion-f'ree in
longitudinal direction

Proceedings of PAC09, Vancouver, Canada, 2009, pp. 4516-4518

E. Gjonaj, T. Lau, T. Weiland, Wakefield Computation with the PBCI Code using a Non-Split Finite Volume Method,
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Finite Volume Time Domain Method

Allocations of E&M Field Vi »
Components on Cartesian Grid
[
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Finite Volume Time Domain Method

Faraday’s Law

d . - .
— | uH dV =—¢ ExdA
R

X
z
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Finite Volume Time Domain Method

DARMSTADT
Faraday’s Law
dijﬂﬁ dV =—§E xdA
tV ov E E
E s senssess o S
Y
E,
HZ
A -
E, Ey,
y
X

z
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Finite Volume Time Domain Method

DARMSTADT
Faraday’s Law
d - L
— | uHdV =—¢ExdA
a1
4-Point Derivative Stencil E, E
j+£ J_E E ------ uﬁ-w nann
d WLkl 1(0EXY OEX) 1|0E, %2 OE, ? ¥ E,
_:uz HZ 2 2 — — X + S y + y
dt 2\ oy oy 2| OX OX :
¢ g i H
OEy _E, ~E, z
ay Ay ¢
an % Ei+l J+E k+E B i j+%,k+— EI Ex
y = y y .......... ..q ............ E
OX A, E, y
y
The transverse derivative operators have averaging in

longitudinal direction, while in FIT they have not. »

z
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Dispersion Properties of Numerical Methods

Numerical phase velocity error

Numerical phase velocity vs propagation direction

VS propagation direction 3D — A=A/5
2D — A=A\/2

Stability Limits .
FIT - A/I 0.02
AR = A /43

AtSZIEVM - AtgFDVM =A

max(AVy,e)
max(AVpy )
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SIBC Time Domain Model

SIBC in Frequency Domain
E, (0) =Zy(w) [ x Hy(w)]

Z.(@) = jwl + +2
s(w) = jw do ]w+,81

Rational Function ApprOX|mat|0n (RFA)

» B. Gustavsen, Improving the pole relocating
properties of vector fitting, IEEE Trans. on Power
Delivery, vol. 21, pp. 1587-1592, 2006
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SIBC Time Domain Mode VRS
SIBC in Frequency Domain >IBC in Time Doma}\llr;
= L, = Transformationto TD, | - d - — =
B (@) =Z,() [7i x Hy(@)] > B @=L Z[RxH ]+ ) Gi(®
i=0 []

Auxiliary Differential Equations (ADE)

Zo(w) = jwl z - ——
s(@) = jol +ao + ]a)+,Bl Go = ap [n X Hy ]

d = - N — <::
00 T BiGi =a; [n X He ]

Rational Function ApprOX|mat|0n (RFA)

» B. Gustavsen, Improving the pole relocating * J.Woyna, E. Gjonaj, and T. Weiland, Broadband
properties of vector fitting, IEEE Trans. on Power surface impedance boundary conditions for higher
Delivery, vol. 21, pp. 1587-1592, 2006 order time domain discontinuous galerkin method,

COMPEL, vol. 33, no. 4, pp. 1082-1096, 2014.
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SIBC Time Domain Model
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Surface Impedance of Good Conductors

- Metal Type | Conductivity Relaxation Time
7 ()= \/ ity [MS/m] [fs]
O'(a))+ Jog, Cu 58 24.6
ﬂ Al 36.6 7.1
o(0) ~ O_'o |_> S-S 316 1.34 2.4
1-jor Ti-6Al-4V 0.5 1.04 (?)
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SIBC Time Domain Model

Surface Impedance of Good Conductors

- Metal Type | Conductivity Relaxation Time

- Jou MS/m fs

7 ()= \/ 2 [Ms/m] [fs]
O'(a))+ Jog, Cu 58 24.6

ﬂ Al 36.6 7.1

o(0) ~ —N S-S 316 1.34 2.4

_ J T Ti-6Al-4V 0.5 1.04 (?)
0.003
Copper

Example : Short bunch

O-Bunch f 10/,lm _ﬂﬂﬂl
s G
C %

f ~ ~5THz N 0-001
GBunch o

2 3

Frequency [THZ]
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SIBC Time Domain Model
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Boundary Effects

Z,(0) =22 (0)+ Z(0)

* Finite Resistivity

7% (@) ~ Jou Z (o) = jol
° olw)+ joe {l
O o, g —1
Yo L ~ r
o(w) ~ 1 jor Hy z
y
g ~10
onide ~7nm

e M. Dohlus. TESLA report 2001-26, 2001
* K. Bane, G. Stupakov, SLAC-PUB-10707, 2004
e A Tsakanian, M. Dohlus, I. Zagorodnov, TESLA-FEL-2009-05, 2009

« Surface Roughness
* Metal Oxidation

+0.01-A

}

~500nm

OXIde rough

rough
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SIBC Time Domain Model

Accuracy of Vector-Fitting technique
Good Conductors

jou VF Npo
L (w)= ~ i _t
s (@) O'(C())-i-j(()&' :> ZS(w)_]wL+a0+ij+ﬁl
i=

Example : Cu - Np=21,
Frequency range ~ 10MHz-5THz, Af~5MHz

o 3 X  Fitted 10°%=
=25 _fd‘“a]yhc g
x E — _1
~ ol 210 &
=) - | -
3 | 2
N 1.5 ""*510'2
pt e
-E — . -
= 10° = * i i
=05k 02 04 06 08 1
= g Frequency [GHz]
< = |
0 1 2 3 4 5

Frequency [ THz ]
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Accuracy of Vector-Fitting technique
Good Conductors
jou VF Npo
Z,(0) = — =) Zs(w)zja)L+a0+Z_—l
O'(a))+ja)5 : 1]w+ﬁl
1=
Example : Cu - Np=21,
Frequency range ~ 10MHz-5THz, Af~5MHz Sensitivity on RFA terms

) _
w3 Tx Fited T 10 f~ 1GHz
E 251~ —Analyic| i i \'_0'10 —
< L e T =10°
T ool g 210 X
N a a ' @ Pw =
;ﬁ 150 o B 2 A2
N i 10 <10
v ¥ e
g 10° i i i i 10_4
50_5“ 02 04 06 08 1 6 9 12 15 18 21 27
é | Frequency [GHz] Np — RFA terms

0 1 2 3 4 5
Frequency [ THz ]
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SFVTD Method with SIBC-TD

Boundary Cells with SIBC Surfaces

Case | Caseu\‘ Case Il
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Control volumes (shaded) at SIBC boundaries (red) and associated
DoFs with respect to a cell volume of primary grid (black).
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SFVTD Method with SIBC-TD 5 s
Semi-Discrete ADE Formulation in | Time Integration
Time Continuous MGE with SIBC !
Faraday’s Law with SIBC - TD ;
. (
i _ Semi-Analytic
o Gi +,Bi Gi = {; h | > Gin :Gin—l e At +ﬂ(l—e_ﬂim)-hn_0'5

(QZ-I— L.AC)%hmO-éc-/h:—c-e—Acf;Gi
v

Ampere’s Law with PEC

Mgie=C~h+jS
ot
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SFVTD Method with SIBC-TD

Semi-Discrete ADE Formulation in
Time Continuous MGE with SIBC

Time Integration

Faraday’s Law with SIBC - TD
hn—QS

iG. + 4 -G =ah Semi-AnaI;l/tic > £ =G
dt i i i i : G_n :G_n—l_ —f; At
d S
&+ L-AC)EthaO-ﬁc-/h:—C-e—Ac-;Gi
_ Semi-Implicit »hmo.s — K" _ At Mﬂl[c e" + Ac ,ZN:GinJ

Ampere’s Law with PEC

+ﬂ(l_e—ﬂiAt).hn—0.5

ZZmaN

e”+1:e”+AtMg,1C hn+0.5_AtM A J:+05

0 i
M, ae =C-h+ ] Mass Matrix at the Boundary

1
yV+0¢0 AC+LAC

M, =

U

I\7I'H_1, M ., A — Diagonal
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Mode-TM, ,,
4 =81.65,m, f ~3.5THz
Opn = 0.58-:10°S/m—> ¢z = 0.94mm
o =1.34-10°S/m— cr =1.43mm A s :
O, =58:10°S/m— cr =9.42mm "
1 Cube cavity - TiAl, mode - TM211 % . “
'5 ! '5 1 Np=21
= 0.8 |
=
)
R ] I S Bt
[
L
S 0.4
L
=
[0 0.2 NUMETICAl oo o Smaggoereene o

5 10 15 20 25
Time/Period
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Numerical Example

DARMSTADT
Multi-Mode Example
Mode Frequency | Filling Time
N Np=21 [T T [GHZ] ¢ 7 [m]
45 e Ty 25.9628 1.1202
N [ Ty 36.7169 0.9420
57 N TMay, 49.7150 0.8095
o i s B Sy LA AP
L TM,qq 63.5956 0.7157
225
& TMey 77.8884 0.6468
= 2
1.5
1
05 20 20 50 80 100 120 140
Time/Period
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Convergence of the Scheme

Reference Solution
Fine Mesh - 1/4 =120

Rel. Error of Filling Time [%]

Mode-TM 211
10 20 30 40 50 60 80
1/A
[ | Fixed Mesh-1i4=60 [ ToeTal
1 N R N B SR | oo 1

W

Reference Solution
Np=27

N

—

o

Rel. Error of Filling Time [%]

6 8 10 12 14 16 18 20
Np - Number of Zs(w) Approx. Terms
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Intermediate Summary

Achievements

» Time Domain SIBC model & RFA Accuracy
» TD-SIBC Implementation in 3D SFVTD
» Stability & Convergence Analyses

» PBCI Mesher Adoption for SFVTD Method
» Implementation of SFVTD Method in PBCI

« PEC-BC
e« TD-SIBC
e Validation

Ongoing Activity

> Initial Fields & Current Generation — Ultra-Relativistic Bunch.
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Initialization of Fields & Current

Initial Field & Current Density Generation

Ultra-Relativistic bunch I:> Only transverse non-zero EM field components
Charge Density

P (%Y, 2)=p (X, Y) p,(2)
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Initialization of Fields & Current ./

Initial Field & Current Density Generation
Ultra-Relativistic bunch I:> Only transverse non-zero EM field components

Charge Density
Pio(%,¥.2) = . (4 Y) 24 () ﬂ
Initialization Strategy
> Create 3D Transverse Electric Field |=—=> | Solve 2D E-Static Problem

2D Poisson Equation
A pop =P (X Y)] &
BC-¢,, =0
O

Create 3D electric potential
by scaling the ¢, with p,,

4
E, =grad, ¢,
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Initialization of Fields & Current
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Initial Field & Current Density Generation

Ultra-Relativistic bunch I:> Only transverse non-zero EM field components

Charge Density
P (XY, 2)=p (%) py(2) ﬂ

Initialization Strategy

> Create 3D Transverse Electric Field | = | Solve 2D E-Static Problem

U

2D Poisson Equation

» Calculate 3D Transverse Magnetic A o,n=p, (X Y)/ &
FﬁldiromEelectrlc I(ilomEoEents. BC —¢,p =0
x =y oo y — =x @
4 Create 3D electric potential
» Check Consistency of Generated Field by scaling the ¢,p with p,,
Components with Update Equations. 3
<

E, =grad, o,

» Create Current Density from
Transverse Magnetic Field.
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Initialization of Fields & Current

3D Transverse Electric Field
2D Potential - p,, K=J 2D Poisson Solver |[===)| PBCI Solver K= | Parallel

@ 3D VEIectric'-i:’otenjtiaI\— Gauss

¢3p = Scale ¢, with longitudinal charge distribution x10° .~
5.7

i = el

y
HZ/'/EJ,'/)-X
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Initialization of Fields & Current

3D Transverse Electric Field
2D Potential - p,, K=J 2D Poisson Solver |[===)| PBCI Solver K= | Parallel

Vv

¢3p = Scale ¢, with longitudinal charge distribution

3D VEIectric'-PotenjtiaI\— Gauss

» Construct Div & Grad FV operators

D} FV-Curl
T
G = (Fz,x Fg,y Fg,y) 0 FiT FE
Div = -G' C=|P 0 PXT
PyT P 0
Transverse E-field @
ei =G, -y

C=C’
J

Check Field Consistency

y
hy 0 =hi° - At-M YPTe} +P,e))' =0 I
i

7’
[
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3D Transverse Magnetic Field :
n—0. n |
h™° < —e; Electric field | E, H, E, H
n—0.5 n = averaging in X-direction : — —
h)™° «e] ' H, E;n H, E;I

Check Field Consistency

0. 0. -0. \r
hos = (h705 pros g
Div-h"** =0
Div-C-h"%° =0
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Initialization of Fields & Current

3D Transverse Magnetic Field l
|
-0.5 |
h:™ « - = Electric field | E, H, E, H
. . Ai . I — —
05 3 averaging in X-direction L E;ﬂ — E,NV
I X . X

Check Field Consistency
n-0. n-0. n-0. T
hos = (h705 pros g
Div-h"** =0
Div-C-h"%° =0

Current Density Generation

n-0.5 T, n-0.5 n-0.5
j; =P, h, ™ + P, hy
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Initialization of Fields & Current

Consistency of Generated Field Transverse Components with Update Equations.

Create longitudinal shift operator - S H-field update

he®® S b =1 -h™ —AtM " - P e]
n+0.5 n-0.5 n-0.5 -1 n
hy©® ={S - h) % = 1 hy° —AtM! - P, €]

=) Fulfilled
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<
® )X




Cie g . : 7 TECHNISCHE
Initialization of Fields & Current L e
Consistency of Generated Field Transverse Components with Update Equations.
Create longitudinal shift operator - S H-field update
he** =S - ™ =1-h™ —AtM - P €]
1405 105 o5 o | =) Fulfilled
hy™ =S -hy™ =1-h" —AtM - P, &
E-field update
n+l .ol _ . an -1 pT n-0.5 -
e =S-e, =1-e +AtM_~ - P, (Shy ) =N Failed
n+l n __ n -1 n-0.5
e, =|S-e, =1-e +At ng - P, (S h, ) o \ -
R E “Error in Ex update - Y2
2 o S
0
. . . -2 B
= Is it because of longitudinal f? /S SN

averaging in P, & P, .

e N ,

IR INRRRELEE S

1

1.2
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Initialization of Fields & Current

Consistency of Generated Field Transverse Components with Update Equations.
E-field update

: — U=(1-5)-e" +AtM;* P (Sh")
Check with charge density distribution "

longitudinally uniform U=(1-5)-ey+AtM_"-P, (S hQ_O'S)

a pamaper st ". — .I.
X10“”“”*””E“wm3ﬂmmmmhvz P

T
S mf
=

Il <
o>

15 June 2015 | TU Darmstadt | Fachbereich 18 | Institut fir Theorie Elektromagnetischer Felder | Dr. Andranik Tsakanian | 33




Initialization of Fields & Current

TECHNISCHE
UNIVERSITAT
DARMSTADT

Consistency of Generated Field Transverse Components with Update Equations.

Check with charge density distribution
longitudinally uniform

a pamaper st ". — I
X10“”““*””E“wm3ﬂmmmmhvz P

E-field update

U=(l1-5)-€ +AtM*-P] (Sh"*)

U=(1-9)-€ +AtM" P, (Sh)™°)

> Initial Fields & Current Generation — Ultra-Relativistic Bunch ...
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Initialization of Fields & Current
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Consistency of Generated Field Transverse Components with Update Equations.

Check with charge density distribution
longitudinally uniform

a pamaper st ". — I
X10“”““*””E“wm3ﬂmmmmhvz P

> Initial Fields & Current Generation — Ultra-Relativistic Bunch ...

Thank You for Your Attention!

E-field update

U=(1-9) e +AtM;* P (Sh)
U=(1-5)-¢e +AtM-P, (Shy*°)
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Numerical EM Field Energy

Numerical EM Field Energy

w=2(E"M, E+HT-M,-H)
2 ¢ #
Correction
term

’ ”'M

it

—
o O
=~
—

—
N

EM Field Energy [J]
< :
R -

S o
©
(@)
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